This page intentionally left blank.
# TABLE OF CONTENTS

1  INTRODUCTION AND PURPOSE ............................................................................... 1  
   1.1  Referenced Documents ..................................................................................... 1  
   1.2  Electronic Plan vs. Traditional Master Plan Reports ........................................... 1  

2  DIGITAL FILE FORMATS ............................................................................................ 1  
   2.1  Mapping Files ..................................................................................................... 1  
   2.2  EPlan Report File ............................................................................................... 2  

3  EPLAN REPORT ......................................................................................................... 2  
   3.1  General Information ........................................................................................... 3  
   3.2  Master Document ............................................................................................... 3  
   3.3  Conceptual Design Maps ..................................................................................... 4  
      3.3.1  Base Mapping and Topography ..................................................................... 4  
      3.3.2  Units ............................................................................................................. 4  
      3.3.3  Map Scale and Size ....................................................................................... 4  
      3.3.4  Stream Centerline ....................................................................................... 5  
      3.3.5  Reach Labels ............................................................................................... 5  
      3.3.6  Feature Appearance and Layer Conventions .............................................. 6  
      3.3.7  Additional Map Components ........................................................................ 7  
      3.3.8  Recommended Text Sizes ............................................................................ 8  
   3.4  Conceptual Design Profiles ................................................................................ 8  
      3.4.1  Units ............................................................................................................. 9  
      3.4.2  Grid and Scale ............................................................................................ 9  
      3.4.3  Profile Lines ............................................................................................... 9  
      3.4.4  Reach Labels ............................................................................................ 9  
      3.4.5  Feature Appearance and Layer Conventions ............................................ 10  
      3.4.6  Additional Profile Components .................................................................. 11  
      3.4.7  Recommended Text Sizes .......................................................................... 12  
   3.5  Creating the EPlan PDF File .............................................................................. 12  
      3.5.1  About Attachments and Links ..................................................................... 13  
      3.5.2  Summary of Steps for creating navigation between the Master, Map, and  
             Profile PDF files: ......................................................................................... 13  
      3.5.3  Detailed Step-by-Step Instructions: .............................................................. 13  
   3.6  Easy-to-Print Maps and Profiles ...................................................................... 14  
      3.6.1  ETP Map and Profile Criteria .................................................................... 17  
      3.6.2  Instruction for Creating ETP Maps and Profiles in AutoCAD .................... 18  
   3.7  Direct Links from Appendix Dividers ............................................................... 19  
   3.8  Cost Estimator Tables ..................................................................................... 19  

4  SUBMITTAL REQUIREMENTS .................................................................................... 20  

5  CHECKLIST ............................................................................................................. 20
This page intentionally left blank.
1 INTRODUCTION AND PURPOSE
The Electronic Plan (EPlan) guidelines were written to offer guidance and direction to consultants developing master plan studies in an electronic format. The guidelines cover the materials to be included in the EPlan files, the process by which they are to be developed and specific details for the final product.

1.1 Referenced Documents
The EPlan guidelines reference several documents. When used in conjunction with these guidelines, these references offer important information for those developing the EPlan. The following should be consulted routinely throughout the study:

- **Checklist** - The checklist identifies the information that is required for planning studies reports and provides a general outline for the report. The consultant is to follow the checklist provided in these guidelines. The checklist is discussed in more detail in Section 5 of these guidelines.

- **EPlan Prototype** - A prototype has been developed to provide an example of completed EPlan files and illustrate the end product from the EPlan guidelines.

- **UDFCD Specifications for Electronic Submittal of FHAD and Master Plan Documents in PDF Format** - Date August 2006, this document was developed as guidance for creating PDFs of the traditional hard copy FHAD and Planning Study reports. These EPlan guidelines provide additional criteria specific to EPlan reports.

1.2 Electronic Plan vs. Traditional Master Plan Reports
By definition, the EPlan is an electronic format of a master plan report. The end product of a traditional Outfall Systems Planning (OSP) or Major Drainageway Planning (MDP) study report was a bound 11"x17" printed document. This meant that all of the content was formatted to fit on 11"x17" pages and still effectively illustrate the results of the planning study. Consequently, the planned improvements were presented on multiple plan and profile sheets using Matchlines for connectivity, breaking up the maps and profiles into small sections. This not only was a very time consuming process, but often poorly illustrated the results of the study from the big picture.

The EPlan is for the most part a traditional planning study report produced in PDF format. The key difference between traditional printed study reports and the EPlan is that there is no hard copy of the final document, thus the maps and profiles are not confined to the 11"x17" size restriction. This allows more freedom in the page size, resulting in fewer sheets and a less fractured overall depiction of the proposed improvements.

2 DIGITAL FILE FORMATS

2.1 Mapping Files
The drawing files may be created in either computer-aided design (CAD) format or geographical information system (GIS) format. The delivered CAD files must be compatible with AutoCAD 2000 or later. GIS files must be compatible with ArcView 3.x or ArcGIS 8.x or later.
2.2 **EPlan Report File**

The EPlan Report is one PDF file containing all elements of the study report including the text, figures, tables, maps, profiles, and other supporting material. The PDF file is created from the native software that originally produced the content (i.e. Microsoft Word, Microsoft Excel, AutoCAD, etc.). The majority of the report is formatted as 11”x17” similar to traditional planning study reports except that the maps and profiles are formatted for larger sheet sizes as deemed necessary. See Sections 3.3 and 3.4 of these guidelines for additional information on formatting maps and profiles.

Consultants should refer to the “UDFCD Specifications for Electronic Submittal of FHAD and Master Plan Documents in PDF Format” written by CH2M Hill dated August 2006. The criteria specified in these EPlan guidelines take precedence for EPlan electronic documents. It is important to make sure that the final EPlan PDF document is well bookmarked and every item listed in the Table of Contents is linked to the appropriate page in the PDF document. This makes the EPlan document easier to navigate and more user-friendly.

3 **EPLAN REPORT**

The engineering and hydrologic information in the EPlan Report should be presented in an organized fashion so that it may be used for development of master drainage plan updates, road and bridge planning and design, design of channel modifications, and design of flood control structures.

The EPlan Report contains hydrology, alternatives evaluation, and conceptual design of proposed improvements. This information is presented in the textual discussion and supporting documents. The textual portion of the EPlan Report provides the reader with background information and supports the analysis for the study. The supporting documents include tables, figures, maps, and profiles referenced in the text.

The following is a brief outline of the report:

- Section 1 Introduction
- Section 2 Study Area Description
- Section 3 Hydrologic Analysis
- Section 4 Hydraulic Analysis
- Section 5 Alternatives Analysis
- Section 6 Conceptual Design
- Section 7 References

Appendix A Project Correspondence
Appendix B Hydrologic Analysis
Appendix C Hydraulic Analysis
Appendix D Wetland and Riparian Inventory
Appendix E Alternatives Analysis
Appendix F Conceptual Design Information
Appendix H Master Plan Maps and Profiles
The Checklist as defined in Section 1.1 of these guidelines outlines the content of the report for each section and appendix. The following sections provide additional direction for specific portions of the Report.

3.1 General Information
3.2 Master Document
3.3 Conceptual Design Maps
3.4 Conceptual Design Profiles
3.5 Creating the EPlan PDF File
3.6 Easy-to-Print Maps and Profiles
3.7 Direct Links from Appendix Dividers
3.8 Useful Information
3.9 Cost Estimator Tables

3.1 General Information
The EPlan consists of a total of five (5) individual PDF files: the parent Master PDF and four (4) attached PDF files of the Conceptual Design Map(s) and Profile(s). The Master PDF file contains the bulk of the report including text, tables, charts, appendices, and the majority of the figures in 11x17-page format. The attached PDF files consist of:

- Large-format Conceptual Design Map (Map)
- Large-format Conceptual Design Profile (Profile)
- 11x17-format views of the Conceptual Design Map (Easy-to-Print Map)
- 11x17-format views of the Conceptual Design Profile (Easy-to-Print Profile)

The Conceptual Design section of the report (Section 6) contains links to the Map and the Profile. When the user clicks on a link in the Master PDF to view the Map or the Profile, the linked PDF is opened in a new instance of Acrobat and zoomed to the corresponding reach on the Map or the Profile. If the linked PDF is already open, then Acrobat zooms to that reach on the Map/Profile in the PDF already open. Likewise, the Map contains links to the Text and Profile; and the Profile contains links to the Text and the Map. This allows the reader to easily flip back and forth between documents using the links and have the ability to view all three side-by-side.

Once completed, the Master PDF and attached files are fully contained in one PDF file for simplified file management.

3.2 Master Document
The Master PDF is 11x17 format and contains everything except the Conceptual Design Maps, Conceptual Design Profiles, and “Easy-to-Print” 11x17 format PDFs of the Maps and Profiles. Section 6 of the report discusses the Conceptual Design improvements on a reach-by-reach basis. The following text should be included at the end of each reach improvement discussion:

CLICK HERE TO VIEW REACH [reach identifier] MAP
CLICK HERE TO VIEW REACH [reach identifier] PROFILE
Substitute “[reach identifier]” with the name of the reach.
This text will be used in the final PDF to link between the Text, Maps, and Profiles. Each detailed discussion of the reach improvements should be accompanied by a link at the end of the discussion. This functionality is intended to replace the traditional plan and profile sheets and therefore is an essential component of a user-friendly EPlan PDF document.

It is important that the style of the text sets it apart from the rest of the text. It is recommended that the font color be blue and underlined to indicate a linked hot spot. The wording of the link text can be modified to fit the particular study and the referenced item.

Refer to Section 3.5 of these guidelines for instructions to create the PDF file and linking the Text, Maps, and Profiles.

3.3 Conceptual Design Maps
The Conceptual Design Maps illustrate the proposed conceptual design improvements. The Maps replace the “plan view” portion of the traditional planning study plan and profile sheets. The linework should clearly depict the limits of the improvements and provide labels to describe the improvements.

3.3.1 Base Mapping and Topography
Base mapping must show all current features, streets with correct names, railroads, airfields, etc. All streets and roads within or near the improvements shall be shown and named.

The base mapping and topography must show and label:
- Existing ground contours (differentiating major and minor contours)
- Jurisdictional boundaries (City and County limits)
- Hydrographic features such as streams, rivers, canals, and flood control structures
- Major junctions and confluences
- Hydraulic structures (culverts, bridges, dams, levees, etc.)
- Streets, roadways, and other transportation features
- Houses and buildings
- Any other pertinent planimetric features located in, or directly adjacent to, the proposed improvements

3.3.2 Units
Units for all distances and elevations are in feet.

3.3.3 Map Scale and Size
Conceptual Design Maps and Conceptual Design Profiles must be at the same horizontal scale. The minimum printed scale of Conceptual Design Maps is 1” = 200’. The horizontal scale should be illustrated by a bar scale and text stating the print scale (e.g. 1”=200’). The orientation of the printed map should be horizontal. The north arrow on the flood map should always point to the left, top, or right of the sheet and never towards the bottom or bottom corners.
Note that Conceptual Design Profiles must be oriented with the downstream end on the left side of the sheet regardless of the Conceptual Design Map orientation (see Section 3.4 of these guidelines for more information on Conceptual Design Profiles). There may be instances that the map and profile do not flow in the same direction (i.e. left on the map does not necessarily correspond to left on the profile).

The Conceptual Design Map and Conceptual Design Profile layouts are to be created to minimize the number of sheets. The printed map size is not to exceed 36” x 120”, but no smaller than 11”x17”. If multiple sheets are necessary because the maximum map size would be exceeded, clearly indicate match lines between the multiple sheets, using a font size easily identified when the PDF sheet is zoomed out, to indicate breaks and provide a key map on each sheet. The map views should be oriented so that individual reaches are not broken across multiple maps.

3.3.4 Stream Centerline
Centerline alignment: The centerline alignment is the line that determines the Conceptual Design Profile. The centerline should follow the low flow channel alignment along the entire stream centerline.

Stationing: All drainageways in the study should have a unique station numbering sequence. The starting station should be the most downstream point of the study limit and increase going upstream. For instance, if the stationing of the main drainageway at the downstream limit of the study is numbered 0+00 then all stationing along the mainstem is higher (e.g. 0+00 to 80+00). For tributaries to the main drainageway, the downstream study limit would be higher than the upstream limit of the mainstem (e.g. 100+00 to 140+00).

3.3.5 Reach Labels
The reaches must be clearly labeled on the map in a manner that allows them to be identified easily when the PDF sheet is zoomed out. Beneath the reach identifier, include the following text:

CLICK HERE TO VIEW REACH [reach identifier] TEXT
CLICK HERE TO VIEW REACH [reach identifier] PROFILE
Substitute “[reach identifier]” with the name of reach.

This text will be used in the final PDF to link between the Text, Maps, and Profiles. Each reach label should be accompanied by links to the Text and the Profile. This functionality is intended to replace the traditional plan and profile sheets and therefore is an essential component of a useful EPlan PDF document.

It is important that the style of the text sets it apart from the rest of the text. It is recommended that the font color be blue and underlined to indicate a linked hot spot. The wording of the link text can be modified to fit the particular study and the referenced item.
Refer to Section 3.5 of these guidelines for instructions to create the PDF file and linking the Text, Maps, and Profiles.

### 3.3.6 Feature Appearance and Layer Conventions

Map features should be formatted in accordance with Table 3.1 Conceptual Design Map Feature Appearance and Layer Conventions. Line styles (patterns, dashes, etc.) should be applied to the feature objects, and not drawn as individual line segments. Annotation and leader lines must be on separate layers from geographic data.

<table>
<thead>
<tr>
<th>TABLE 3.1 Conceptual Design Map Feature Appearance and Layer Conventions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FEATURE</strong></td>
</tr>
<tr>
<td>CONCEPTUAL DESIGN ELEMENTS</td>
</tr>
<tr>
<td>Channelization Limits</td>
</tr>
<tr>
<td>Grade Control Structures</td>
</tr>
<tr>
<td>Bank Stabilization</td>
</tr>
<tr>
<td>Detention Basin</td>
</tr>
<tr>
<td>Storm Sewer</td>
</tr>
<tr>
<td>Study Limits</td>
</tr>
<tr>
<td>Watershed Boundary</td>
</tr>
<tr>
<td>STRUCTURE ELEMENTS</td>
</tr>
<tr>
<td>Stream Centerline</td>
</tr>
<tr>
<td>Centerline Stationing</td>
</tr>
<tr>
<td>Culverts</td>
</tr>
<tr>
<td>Bridges</td>
</tr>
<tr>
<td>Foot Bridges</td>
</tr>
<tr>
<td>Other Structures</td>
</tr>
<tr>
<td>Structure Text</td>
</tr>
<tr>
<td>FLOODPLAIN ELEMENTS</td>
</tr>
<tr>
<td>100-year floodplain before improvements</td>
</tr>
<tr>
<td>Approximate 100-year floodplain after improvements</td>
</tr>
<tr>
<td>BASE MAP ELEMENTS</td>
</tr>
<tr>
<td>Roads</td>
</tr>
<tr>
<td>Road Text</td>
</tr>
<tr>
<td>Railroads</td>
</tr>
</tbody>
</table>
### 3.3.7 Additional Map Components

Maps should include the following information:

- EPlan study name
- Date of EPlan (month and year)
- North arrow and scale (See Section 3.3.3 of these guidelines for more information)
- Legend including symbology for channel alignment, floodplain boundaries, contours, structural improvements.
- Information about mapping source including the date, horizontal datum, and vertical datum.
- Consultant’s information
- Matchlines and key map if more than one Map is produced.
- The following instructions for printing portions of Map PDF to scale:

  Instructions to print an area smaller than the full page to scale:
  1. Using the "Snapshot" tool, select the desired area to print.
  2. Click File>Print...
  3. Select your printer from the printer dropdown menu.
  4. Set the desired paper size using the printer "Properties" menu.
  5. Choose the "Selected graphic" option under "Print Range".
  6. Select "None" from the "Page Scaling" dropdown menu.
  7. Unselect "Choose paper source by PDF page size".
  8. Click "OK" to print selection.

- The following text from the Selected Plan instructions.

  This drawing is for master planning purposes and represents preliminary and conceptual engineering. Alternatives to this outfall system will be considered by local agencies and the Urban Drainage and Flood Control District provided the alternative offers an equivalent intent of the plan, including hydraulic capacity, water quality, stream stability and natural waterway features. The alternative must comply with all requirements of
the local jurisdiction and the Urban Drainage and Flood Control District. In addition, there may be state and federal requirements that will need to be considered and met. This drawing does not provide a final design and shall not be used for construction purposes.

Local cities, towns, and counties manage and regulate all land use change, development and redevelopment activities within and adjacent to the 100-year floodplains in order to prevent, to a maximum extent possible, future flood damages to buildings and structures from the 100-year flood and to minimize damages from larger floods. The recommendations of this plan provide a set of options subscribed to by cities, towns and counties in carrying out their floodplain management and regulatory responsibilities and obligations.

Many activities that occur in or affect ditches, drainages, creeks, ponds or wetlands require a Section 404 permit authorization from the US Army Corps of Engineers. During preliminary design, and prior to final design or starting work, contact the Corps’ Denver Regulatory Office at 303-979-4120 for appropriate permit authority to avoid compromising and delaying the completion of the project.

3.3.8 Recommended Text Sizes
The reader will view the Map PDF at multiple zoom scales. When viewing the full page, reach labels should be large enough that the reader can easily target the area of interest. The size of labeling text on the Map should be an appropriate size for the Map’s particular scale so that they can be easily read on a printed full-size Map. Table 3.2 below lists suggested text sizes for various components of the Map.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>PRINTED HEIGHT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map Title</td>
<td>1.0 inch</td>
</tr>
<tr>
<td>Map Subtitle</td>
<td>0.50 inch</td>
</tr>
<tr>
<td>Reach Identifier</td>
<td>0.30 inch</td>
</tr>
<tr>
<td>Links (to Text and Profile below Reach Identifier)</td>
<td>0.14 inch</td>
</tr>
<tr>
<td>Street Names</td>
<td>0.30 inch</td>
</tr>
<tr>
<td>General Feature Labels</td>
<td>0.14 inch</td>
</tr>
<tr>
<td>Centerline Stationing</td>
<td>0.14 inch</td>
</tr>
<tr>
<td>Matchline</td>
<td>0.20 inch</td>
</tr>
</tbody>
</table>

3.4 Conceptual Design Profiles
Conceptual Design Profiles should be developed to depict the proposed improvements for the areas defined in the scope of work. The digital profiles should be one continuous profile for each drainageway. The profiles should be oriented with increasing stationing from left to right so that the most downstream point begins to the left.
Note that Conceptual Design Maps must be oriented so that the north arrow points to the left, top, or right of the sheet regardless of the Conceptual Design Profile orientation (see Section 3.3 of these guidelines for more information on Conceptual Design Maps). There may be instances that the map and profile do not flow in the same direction (i.e. left on the map does not necessarily correspond to left on the profile).

3.4.1 Units
Units for all distances and elevations are in feet.

3.4.2 Profile Scale and Size
Conceptual Design Maps and Conceptual Design Profiles must be at the same horizontal scale. The minimum printed-horizontal scale of Conceptual Design Profiles is 1” = 200’. The minimum profile vertical scale is 1” = 20’. The horizontal scale should be illustrated by a bar scale and text stating the print scale (e.g. 1” = 200’).

The Conceptual Design Map and Conceptual Design Profile layouts are to be created to minimize the number of sheets. The printed map size is not to exceed 36” x 120”, but no smaller than 11”x17”. If multiple sheets are necessary because the maximum map size would be exceeded, clearly indicate match lines between the multiple sheets, using a font size easily identified when the PDF sheet is zoomed out, to indicate breaks and provide a key map on each sheet.

3.4.2 Grid and Scale
The digital profiles shall be plotted on a grid. The horizontal scale of the profile should match the horizontal scale of the maps. The minimum vertical scale is 1” = 20’. Horizontal axis grid lines should be spaced every 0.5 inch on the printed flood profile. Major vertical axis grid lines should be spaced every 0.25 inch on the printed flood profile with minor vertical grid lines representing every 1-foot of vertical elevation.

Label the horizontal axis grid lines with the stations that correspond to the stations along the stream centerline on the Maps at every major horizontal grid line. Label the vertical axis grid with elevations at 10’ intervals. Elevation labels should be repeated at least every 10 inches on the printed flood profile.

3.4.3 Profile Lines
Profiles are to include lines for the thalweg (existing and proposed stream bed) and 100-year water surface elevations before and after the improvements. All existing and proposed structural features including culverts, bridges, grade control structures, and storm sewers are to be shown on the profile. See Table 3.2 for specific formatting requirements.

3.4.4 Reach Labels
The reaches must be clearly labeled on the profile in a manner that allows them to be identified easily when the PDF sheet is zoomed out. Beneath the reach identifier, include the following text:

CLICK HERE TO VIEW REACH [reach identifier] TEXT
This text will be used in the final PDF to link between the Text, Maps, and Profiles. Each reach label should be accompanied by links to the Text and the Map. This functionality is intended to replace the traditional plan and profile sheets and therefore is an essential component of a useful EPlan PDF document.

It is important that the style of the text sets it apart from the rest of the text. It is recommended that the font color be blue and underlined to indicate a linked hot spot. The wording of the link text can be modified to fit the particular study and the referenced item.

Refer to Section 3.5 of these guidelines for instructions to create the PDF file and linking the Text, Maps, and Profiles.

### 3.4.5 Feature Appearance and Layer Conventions

Profile features should be formatted in accordance with Table 3.3 Conceptual Design Profile Feature Appearance and Layer Conventions. Line styles (patterns, dashes, etc.) should be applied to the feature objects, and not drawn as individual line segments. Annotation and leader lines must be on separate layers from geographic data.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>LAYER NAME</th>
<th>APPEARANCE</th>
<th>LABEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thalweg (Stream bed) before improvements</td>
<td>THALWEG</td>
<td>Black, short-dash line,</td>
<td>Average slope</td>
</tr>
<tr>
<td>Future/Approximate thalweg (Stream bed) after improvements</td>
<td>THALWEG FUTURE</td>
<td>Black, solid line</td>
<td>Average slope</td>
</tr>
<tr>
<td>100-year flood profile before improvements</td>
<td>100-YEAR PROFILE</td>
<td>Blue, solid line</td>
<td>Label line with source of profile</td>
</tr>
<tr>
<td>Approximate 100-year flood profile after improvements</td>
<td>100-YEAR PROFILE FUTURE</td>
<td>Black, long-dash line</td>
<td>“Approximate Future 100-Year WSEL”</td>
</tr>
<tr>
<td>Grade Control Structures, Storm Sewer, Culverts, Bridges, Foot Bridges, and Other Structures</td>
<td>STRUCTURE</td>
<td>Existing: Black, dashed line Proposed: Black, solid line</td>
<td></td>
</tr>
<tr>
<td>Structure Text</td>
<td>STRUC TEXT</td>
<td>Black</td>
<td>Station, Existing size and Proposed size, 100-year flow, structure capacity if different from 100-year flow</td>
</tr>
<tr>
<td>Study Limits</td>
<td>LIMITSTUDY</td>
<td>Black, solid line</td>
<td>Label study limit</td>
</tr>
<tr>
<td>Grid Lines</td>
<td>GRID</td>
<td>Thin black or gray line</td>
<td></td>
</tr>
<tr>
<td>FEATURE</td>
<td>LAYER NAME</td>
<td>APPEARANCE</td>
<td>LABEL</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------</td>
<td>------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Text (Stationing, elevations,</td>
<td>TXT-PROFILE</td>
<td>Black</td>
<td>Label elevations at least every 10 feet. Label stations at</td>
</tr>
<tr>
<td>structures)</td>
<td></td>
<td></td>
<td>least every 500 feet.</td>
</tr>
<tr>
<td>Matchlines</td>
<td>MATCHLINE</td>
<td>Thick black solid line</td>
<td>“Matchline”</td>
</tr>
</tbody>
</table>

### 3.4.6 Additional Profile Components

Maps should include the following information:
- EPlan study name
- Date of EPlan (month and year)
- Horizontal and vertical scale (See Section 3.4.2 of these guidelines for more information)
- Legend including symbology for channel thalweg, flood profile, and structural improvements.
- Consultant’s information
- Matchlines and key map if more than one Profile is produced.
- The following instructions for printing portions of Profile PDF to scale:

  **Instructions to print an area smaller than the full page to scale:**
  1. Using the "Snapshot" tool, select the desired area to print.
  2. Click File > Print...
  3. Select your printer from the printer dropdown menu.
  4. Set the desired paper size using the printer “Properties” menu.
  5. Choose the “Selected graphic” option under “Print Range”.
  6. Select “None” from the “Page Scaling” dropdown menu.
  7. Unselect “Choose paper source by PDF page size”.
  8. Click “OK” to print selection.

- The following text from the Selected Plan instructions.

  **This drawing is for master planning purposes and represents preliminary and conceptual engineering. Alternatives to this outfall system will be considered by local agencies and the Urban Drainage and Flood Control District provided the alternative offers an equivalent intent of the plan, including hydraulic capacity, water quality, stream stability and natural waterway features. The alternative must comply with all requirements of the local jurisdiction and the Urban Drainage and Flood Control District. In addition, there may be state and federal requirements that will need to be considered and met. This drawing does not provide a final design and shall not be used for construction purposes.**

  **Local cities, towns, and counties manage and regulate all land use change, development and redevelopment activities within and adjacent to the 100-year floodplains in order to prevent, to a maximum extent possible, future flood damages to buildings and structures from the 100-year flood and to minimize damages from larger floods.**
recommendations of this plan provide a set of options subscribed to by cities, towns and counties in carrying out their floodplain management and regulatory responsibilities and obligations.

Many activities that occur in or affect ditches, drainages, creeks, ponds or wetlands require a Section 404 permit authorization from the US Army Corps of Engineers. During preliminary design, and prior to final design or starting work, contact the Corps' Denver Regulatory Office at 303-979-4120 for appropriate permit authority to avoid compromising and delaying the completion of the project.

3.4.7 Recommended Text Sizes

The reader will view the Profile PDF at multiple zoom scales. When viewing the full page, reach labels should be large enough that the reader can easily target the area of interest. The size of labeling text on the Profile should be an appropriate size for the Profile’s particular scale so that they can be easily read on a printed full-size Profile. Table 3.4 below lists suggested text sizes for various components of the Map.

<table>
<thead>
<tr>
<th>TABLE 3.4</th>
<th>Conceptual Design Profile Recommended Text Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Printed Height</td>
</tr>
<tr>
<td>Map Title</td>
<td>1.0 inch</td>
</tr>
<tr>
<td>Map Subtitle</td>
<td>0.50 inch</td>
</tr>
<tr>
<td>Reach Identifier</td>
<td>0.50 inch</td>
</tr>
<tr>
<td>Links (to Text and Map below Reach Identifier)</td>
<td>0.14 inch</td>
</tr>
<tr>
<td>Street Names</td>
<td>0.30 inch</td>
</tr>
<tr>
<td>General Feature Labels*</td>
<td>0.10-0.14 inch</td>
</tr>
<tr>
<td>Grid Stationing and Elevation Labels*</td>
<td>0.10-0.14 inch</td>
</tr>
</tbody>
</table>

* Preferred height is 0.14 inch, but may crowd the profile. No smaller than 0.10 inch is recommended.

3.5 Creating the EPlan PDF File

What makes an EPlan different from other PDF versions of the traditional Master Planning Study, is that the Conceptual Design improvements in the EPlan are displayed on large-format Maps and Profiles. Unlike the traditional Plan and Profile sheets that displayed only a small portion of the drainageway at one time, the EPlan Maps and Profiles offer the reader a more continuous view of the Conceptual Design improvements.

This requires the Text, Maps, and Profiles to all reside in different sections or locations of the document; the Text is in 11x17 format and the Maps and Profiles are on separate large-format pages. In developing the EPlan Guidelines it was important that the reader did not lose the ability to view the Map and Profile alongside the textual discussion and cost estimates of the reach improvements. This functionality is provided through links in the EPlan PDF file between the Text, Map, and Profile.
3.5.1 About Attachments and Links
Acrobat lets the user attach PDF files to an Adobe PDF document so that the reader can open them for viewing. If the PDF document is moved to a new location, the attachments automatically go with it. Attachments are added by using the Attach A File tool and linked from the parent document. In the case of the EPlan PDF, the parent document is the Master PDF and the attachments are the Map, Profile, and Easy-to-Print PDF files. A reader can click on links within the Text to jump to the Map or Profile zoomed to the corresponding reach. Likewise, links on the Map and Profile provide similar functionality.

The following instructions provide information for creating the navigation mechanism in the EPlan document files. This requires PDF editing software. The following instructions are tailored for use with Adobe Acrobat Standard, Acrobat Pro, or Acrobat Pro Extended.

3.5.2 Summary of Steps for creating navigation between the Master, Map, and Profile PDF files:
1. **Compile PDF files**
   - Compile the 3 PDF files: Master, Map, and Profile. (Navigation to the Easy-to-Print Map and Profile PDF files is discussed in Section 3.7 of these guidelines.)
2. **Create Destinations**
   - Create uniquely named destinations in each of the PDF files that set the user’s view when a link is clicked.
3. **Attach Map and Profile to Master PDF**
4. **Create Links**
   - Create the links in the Master, Map, and Profile PDF files setting the links to the named destinations created in Step 2.
5. **Test Links**
   - Click through each of the links making adjustments to destinations and changes to link assignments.
3.5.3 Detailed Step-by-Step Instructions:

**Step 1. Compile PDF files.** Using Adobe Acrobat, compile the three individual PDF files: Master, Map, and Profile PDF files. For example purposes these will be referred to as Master.pdf, Map.pdf, and Profile.pdf, respectively. Other file names can be used to suit the particular project. Refer to Section 2.1 of these guidelines for Mapping File requirements for the Map and Profile.

For assistance in creating these PDF files, please refer to Adobe Acrobat help files or other numerous resources on the internet. These instructions will focus on the specific, less familiar functions of Acrobat to provide navigation for the EPlan PDF files.

**Step 2. Create Destinations.** Destinations enable the ability to set navigation paths across a collection of Adobe PDF documents. Links set between the Master, Map, and Profile PDFs are assigned to named destinations in each of the three PDF files.

**Assigning Text Designations.** The following describes how to assign destinations in Master.pdf.

1. Open Master.pdf
2. Move to the first detailed conceptual design reach discussion in Section 6 of the report. This is the portion of the report that describes the conceptual design improvements on a reach-by-reach basis and includes the reach's conceptual cost estimate.
3. Set the zoom level to “Fit Page” (hot key: Ctrl+0).
5. Click Create New Destination.
6. Type the name of the destination and press Enter. It is recommended that each of the destinations be uniquely named and provide clues to whether it is assigned to a destination in the text, on the map, or on the profile and a short reach ID. These instructions name the destinations in the text with a T and the reach ID. The destination for the first reach is named “T F1” to represent a Text destination for Reach F1. The Map and Profile destinations for Reach F1 are named similarly “M F1” and “P F1”, respectively.
7. Repeat steps 2 through 7 for each of the reaches.
8. Save Master.pdf.

Note: To reset a destination, navigate to the desired view including the zoom scale, right click on the name of the destination in the list on the Destinations Tab and click Set Destination. To rename a destination, right click on the name on the Destinations Tab and enter the new name.

**Assigning Map and Profile Designations.** The following describes how to assign destinations in Map.pdf and Profile.pdf. The process of assigning destinations is virtually identical for Map.pdf and Profile.pdf. The steps directly below reference only the Map.pdf file. To assign destinations to Profile.pdf, substitute “Profile.pdf” and follow the steps verbatim.

1. Open Map.pdf.
2. Move to the first reach on the Conceptual Design Map. Zoom and pan to the desired view.

   This is the view and scale that the user will see when a link to the Map is clicked. It is recommended that the view be set so that the entire reach is visible on the screen at one time and be set to a value between 10% and 40% zoom. In the event that the entire reach does not fit on screen at 40% zoom, ensure that the reach label is visible and that the view displays the reach improvements near the middle of the alignment.

4. Click Create New Destination.
5. Type the name of the destination and press Enter.

   It is recommended that each of the destinations be uniquely named and provide clues to whether it is assigned to a destination the in text, on the map, or on the profile and a short reach ID. These instructions name the destinations in the Map with an M and in the Profile with a P followed by the reach ID. The destination for the first reach on the Map is named “M F1” to represent a Map destination for Reach F1. The Text and Profile destinations for Reach F1 are named similarly “TF1” and “P F1”, respectively.

6. Repeat steps 2 through 5 for each of the reaches.
7. Save Map.pdf (or Profile.pdf).
8. Save Master.pdf.

Note: To reset a destination, navigate to the desired view including the zoom scale, right click on the name of the destination in the list on the Destinations Tab and click Set Destination. To rename a destination, right click on the name on the Destinations Tab and enter the new name.

Uniquely named destinations are the key to programming the links to jump to a location in the Master, Map, or Profile. Named destinations can be reassigned without modifying the link to the destination, whereas a typical PDF link points to a page number in a PDF document. If pages are inserted, moved, or deleted, the link still points to the assigned page number and not the original, intended location. Step 4 provides instructions for linking to the assigned destinations.

Step 3. Attach Map and Profile to Master PDF. In order for the Master PDF to be wholly portable within one PDF file, the Map and Profile PDF files must be attached to the Master PDF. Note: Once Map.pdf and Profile.pdf are attached to Master.pdf, they are autonomous instances of Map.pdf and Profile.pdf. Changes to the original Map.pdf and Profile.pdf files will not be reflected in the attached PDFs without replacing them. For this reason, it is recommended that all changes to the PDFs are complete prior to attaching to Master.pdf.
The following describes how to attach Map.pdf and Profile.pdf to Master.pdf.

1. Open Master.pdf.
3. Click Add Attachments.
4. Browse to the location of Map.pdf, click on the file, and click Open. Map.pdf will be listed on the Attachments Tab.
5. Repeat steps 3 and 4 to attach Profile.pdf.

**Step 4. Create Links.** The links provide the user the ability to jump from the text to a zoomed in location of the Conceptual Design Map or Profile for the corresponding reach. The links consist of a hot spot in the text or on the Map or Profile that when clicked navigates to the assigned destinations created in step 2.

The following is the procedure for creating a link and assigning it to the corresponding destination. The instructions below specifically create and assign a link from the text (Master.pdf) to the corresponding reach on the Map (Map.pdf), creating a hot spot link over “CLICK HERE TO VIEW REACH F1 MAP” which will open Map.pdf and zoom to destination “M F1” set in step 2 above. These steps apply to all links between Master.pdf, Map.pdf, and Profile.pdf, or any other named destinations.

1. Open both Master.pdf and Map.pdf.
2. In Master.pdf locate the text that references the link to Map.
3. Choose Tools > Advanced Editing > Link Tool, or select the Link tool on the Advanced Editing toolbar. The pointer becomes a cross hair (+), and any existing links in the document, including invisible links, are temporarily visible.
4. Drag to create a rectangle around the link text “CLICK HERE TO VIEW REACH F1 MAP”. This defines the link’s hot spot area where the link is active.
5. In the Create Link dialog box, choose the following settings:
   - Link Type: Invisible Rectangle
   - Highlight Style: None
   - Link Action: Custom Link

6. Click Next.
7. In the Link Properties dialog box, click the Actions tab.
8. Set Select Action to “Go to a page view”.
9. Click Add…. The Create Go to View dialog box will open and prompt you to select the target view.
11. In the Destinations Tab of Map.pdf, double click on the corresponding destination “M F1” in the list. The Create Go To View dialog box will close. Note: Because the dialog box closes so abruptly, this may be perceived that the action was not completed properly. Check the Actions Tab before assuming that the destination was not assigned.
12. In the Link Properties dialog box on the Actions tab, click on “Go to a page in another document” listed under Actions.
13. Click Edit.
14. In the Go to page in another document dialog box, for Open in: select “New Window”.
15. Click OK.
16. Click OK in the Link Properties dialog box.
17. Repeat steps 2 through 16 to create a link for each reference to the Text, Map, and Profile throughout the Master, Map, and Profile.
18. Save file. Note: To save changes in the attached Map.pdf and Profile.pdf files, click Save in both the attached file and Master.pdf.

Note: Links between the text and the Easy-To-Print Maps and Profiles are not required, except from the Easy-To-Print Appendix Divider. See 3.6 for information on the Easy-To-Print Maps and Profiles.

To edit a link:

1. Choose Tools > Advanced Editing > Link Tool, or select the Link Tool on the Advanced Editing toolbar. The pointer becomes a cross hair (+), and any existing links in the document, including invisible links, are temporarily visible.
2. Right click on the link.
3. Click Properties...
4. In the Link Properties dialog box, make any changes and click Close. More specifically, to change the Named Destination or Open In setting, click Go to a page in another document listed on the Actions tab and click Edit.

Step 5. Test Links. Test all of the links to check that the proper destinations were assigned and that the Map and Profile are open in a new window when they are not already open.

3.6 Easy-to-Print Maps and Profiles
The Easy-to-Print (ETP) Maps and Profiles are a series of static snapshots of portions of the large-format Conceptual Design Maps and Profiles discussed in Sections 3.3 and 3.4 of these guidelines respectively. Even though smaller sections of the large-format Maps and Profiles can be printed from Adobe Acrobat using the “Print to Scale Instructions” provided on the Maps and Profiles, printing large sections of the study area can be cumbersome. The ETP documents cover all of the content on the large-scale pages in a format that can be printed on 11x17 paper at a suitable scale. The ETP Maps and Profiles are created solely as an alternate means of printing 11x17 Maps and Profiles. The ETP Map and Profile PDF files are static and do not contain links between each other or the text.

3.6.1 ETP Map and Profile Criteria
The ETP Maps and Profiles should adhere to the following criteria:
1. Two separate files should be created, one named “EasyToPrintMap.pdf” and the other named “EasyToPrintProfile.pdf”. These files are attached to the Master PDF file and linked within the Master PDF file from the ETP Appendix Divider. See Section 3.5.3, Step 3 of these guidelines for instructions on attaching individual PDF files to the Master PDF file. See Section 3.5.3, Step 4 of these guidelines for instructions on creating links to the attached PDF files.
2. They must represent an exact static copy of the Conceptual Design Maps and Profiles including the content and page orientation.

3. The PDF pages must be landscape 11"x17".

4. The ETP Maps and Profiles should be at a scale half that of the full-size Maps and Profiles. For instance, if the Map/Profile is at a scale of 1"=200', then the 11x17 ETP Map/Profile should be at a scale of 1"=400'.

5. The pages of the ETP PDF documents should be ordered so that they represent the upper left portion of the Maps and Profiles first and follow along the drainageway in a logical manner.

6. When possible, the entire length of the reach should be displayed on one single 11x17 page, relatively centered within the page limits. If a reach is too long to display entirely on one 11x17 page, multiple pages may be necessary. In this case, try to fill the consecutive pages as much as possible with that particular reach, even if large areas are repeated.

7. Each page of the ETP Maps and Profiles should be oriented to display the reach name on all pages, when possible.

3.6.2 Instruction for Creating ETP Maps and Profiles in AutoCAD

For those using AutoCAD to produce the large-scale Maps and Profiles, the following instructions provide one method of producing the ETP PDF pages from the large-scale Maps and Profiles.

1. In the Map/Profile drawing file, create a new layer in AutoCAD and set it to be the current layer. Note: It is also recommended, that the layer’s print visibility is turned off in the Layer Manager so that the rectangles created in Steps 2-4 are not visible in the PDF plots.

2. In paper space (Layout tab), draw a rectangle that is 32" wide x 20" tall. This rectangle will be used in subsequent steps to designate the 11x17 views. Note: This will allow for a ½" white border around the 11x17 page.

3. Copy the rectangle and move it to the desired location on the Map/Profile, centering it over the first reach (or the first portion of the first reach).

4. Repeat step 3 until all of the 11x17 views have been arranged to represent the entire Map/Profile.

5. To print the 11x17 views to PDF, open the print dialog box and specify the following settings:
   a. Select the desired PDF printer and specify the printer setting.
   b. Select the desired Plot Style table.
   c. Set the page size to 11x17
   d. Set the orientation to landscape
   e. Set the scale to 1:2
   f. Select “Center plot”

6. In the print dialog box under the Plot Area Section, click “Window” to specify the desired print area.

7. Select the desired rectangle, snapping to the endpoints of the rectangle view.

8. Click Plot to create the PDF file.

Once all of the Map/Profile pages are created, assemble them into ETP Map/Profile PDF files: one named “EasyToPrintMap.pdf” containing all of the 11x17 Maps and one
named “EasyToPrintProfile.pdf” containing all of the 11x17 Profiles. Use the methodology discussed in Section 3.5.3 of these guidelines to attach these PDF files to the Master PDF.

### 3.7 Direct Links from Appendix Dividers

Direct links should be provided on the Appendix Dividers near the end of the Master PDF to open the Map, Profile, and ETP Maps/Profiles. These links open the attached PDF files (if not already open) and zoom to the full-page extent of the first page of the Map, Profile, ETP Maps, or ETP Profiles.

Appendix G Conceptual Design Maps divider should include the following text below the divider title:

- CLICK HERE TO VIEW FULL-SIZE MAP
- CLICK HERE TO VIEW PRESET 11X17 PRINTABLE MAPS

Appendix G Conceptual Design Profiles divider should include the following text below the divider title:

- CLICK HERE TO VIEW FULL-SIZE PROFILE
- CLICK HERE TO VIEW PRESET 11X17 PRINTABLE PROFILES

It is important that the style of the text sets it apart from the rest of the text. It is recommended that the font color be blue and underlined to indicate a linked hot spot. The wording of the link text can be modified to fit the particular study and the referenced item.

Refer to Section 3.5.3 of these guidelines for instructions on how to set destinations and assign links to them. The links on the appendix dividers should be assigned to open the attached PDF files (if not already open) and zoom to the full-page extent of the first page of the Map, Profile, ETP Maps, or ETP Profiles.

### 3.8 Cost Estimator Tables

UDFCD has developed Cost Estimator Excel spreadsheets to assist consultants in developing budgetary cost estimates for the EPlan conceptual design improvements. The spreadsheets simplify the estimating process by standardizing the information required and the manner in which it is presented. The most updated version of the Cost Estimator spreadsheet should be obtained from UDFCD to ensure that the unit prices are up-to-date.

Each reach must have a detailed cost estimate completed with the assistance of the Cost Estimator. The following are brief instructions to incorporate the Cost Estimator tables into the EPlan text. Consult the Cost Estimator help files/information for additional information.

1. Fill out a Sheet Cost tab for each Reach.
2. Click on the Filter Summary Sheet button.
3. Copy the resulting table to the reach description in the text.
Below is an example of a completed reach improvement description with the summarized Cost Estimator table.

4 SUBMITTAL REQUIREMENTS

The deliverables for all draft and final submittals is the EPlan PDF file on CD(s) submitted to UDFCD and each of the project sponsors for review. The draft review set represents the final report as much as possible and should contain all items required by the checklist. Clearly mark the PDF pages with “DRAFT” and use the words “Draft” in the PDF file name to distinguish it from the final DFHAD PDF file. The contract will indicate the number of CDs to be submitted for review. This is typically one set for each reviewing agency.

The CD is to contain one PDF file that encompasses all components of the EPlan report. Follow the directions in the “UDFCD Specifications for Electronic Submittal of FHAD and Master Plan Documents in PDF Format” written by CH2MHill dated August 2006 for production of CDs.

5 CHECKLIST

The checklist identifies the information that is required for EPlan reports and provides a general outline for the report. A copy of the completed checklist (provided in the Agreement with UDFCD) should accompany the draft and final submissions to ensure all pertinent materials have been included in the EPlan report. A sample checklist accompanies these guidelines.